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Introduction

The Form EIA-23, “Annual Survey of Domestic Oil and Gas Reserves,” gathers and summarizes credible and
timely data regarding proved reserves and production of crude oil, natural gas, lease condensate and other
related matters. The Government will use the resulting information to develop national and regional estimates
of proved reserves of domestic crude oil and natural gas liquids and to facilitate national energy policy
decisions.

Each year the EIA posts an electronic version of the Form EIA-23 (including form completion instructions)
to the EIA web site, at this address:

http://www.eia.gov/survey/#eia-23l

The form and instructions describe who is required to file a Form EIA-23 and provide definitions of the data
requested.

This system, the Form EIA-23 Reserves Information Gathering System (RIGS), provides respondents with
an efficient and effective means for filing the form using a personal computer (PC). It is available for
download at the following address:

http://www.eia.gov/survey/form/eia_23l/rigs.cfm

You have a choice of submitting your data via either Secure File Transfer, diskette or e-mail (see section titled
“Create Submission File” for detailed instructions). This User’s Guide provides instructions for using RIGS.

If you require any assistance in installing or running RIGS, call the EIA at 1 (800) 879-1470 between 8:30 a.m.
and 5:00 p.m. EST.

Hardware / Software Requirements

The minimum hardware requirements needed to install and use RIGS are:

0 An IBM-compatible personal computer (PC), with a CD drive
(CD drive is only necessary if you are installing from a CD)

0 The Windows operating system (XP, Vista, 7, 8, or 10)
o} A hard drive with at least 20.0 megabytes of free disk space
o] Internet connection and browsing software (Internet Explorer, Firefox, Netscape, etc.)

(to download the installation program and submit via Secure File Transfer)
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Installing the RIGS Software
To install the EIA-23 RIGS on your PC:
1) Open your Internet browser (Internet Explorer, Firefox, etc.), and go to the following address:

http://www.eia.gov/survey/form/eia 23l/rigs.cfm

2) Click the “Download RIGS Application” link under the “Downloading and Installing” heading.

You are prompted to either “Run this program from its current location” or “Save this program to
disk.” Select “Save this program to disk,” and click the OK button. Depending on your browser,
you may only see a slightly different dialog box; select the equivalent of “Save File” to continue.

3) A box is displayed, asking where you wish to copy the “RIGS_2015.EXE" file. You may copy it
anywhere on your hard drive, but it is recommended that you NOT copy it directly to your root
directory, C:\. The directory in which you copy this file is NOT necessarily the directory where the
system will be installed. The file is a self-extracting compressed file (zipped).

4) When the download is finished, click the Open Folder button in the Download Complete dialog
box, and double-click on the newly-downloaded RIGS 2015.EXE file.

5) As the RIGS install begins, an InstallShield Welcome screen is displayed; click the Next button
to continue. Enter your User Name and Company Name in the next screen, and click Next.

6) A Choose Destination Location screen is displayed. The default directory to which the system
will be installed is: C:\RIGS 2015 (If you wish to change the directory, click the Browse
button.) Click the Next button to continue the installation.

7) Next, the Select Program Folder box is displayed. The name you enter will be the name you see in
your Windows “Programs” menu. The default is RIGS 2015. Click the Next button; the Start Copying
Files screen is displayed. Click the Next button to perform the installation.

8) When the InstallShield Wizard Complete screen is displayed, click the Finish button to exit
the setup program.

If you do not have an Internet connection, EIA can mail you a RIGS installation CD. To install the EIA-23
RIGS on your PC via CD:

1) Insert the RIGS CD into your PC’s CD drive.

2) If the install process begins automatically, go to step 4; if the install process does not begin
upon insertion of the CD, open the Windows “Run” command (accessible from the “Start” button).
In the “Open” box, type:

D:\RIGS 2015 Installation.exe
[Where D is the drive letter for your CD ROM; yours may differ (i.e., E or F)]
3) Click the OK button.

Note: If an installation error message appears, see the “Installation Error Messages” section on
the next page. If no error message appears, go to the next step.
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4) As the install begins, an InstallShield Welcome screen is displayed; click the Next button to
continue. Enter your User Name and Company Name in the next screen, and click Next.

5) A Filing System Setup screen is displayed. The default directory to which the system will be
installed is:

C:\RIGS 2015

(If you wish to change the directory, click the Browse button.)

Click the Next button to continue the installation to the default directory.

6) Next, the Select Program Folder box is displayed. The name you enter will be the name you
see in your Windows “Programs” menu. The default is RIGS 2015. Click the Next button; the
Start Copying Files screen is displayed. Click the Next button to complete the installation.

7) A dialog box will appear, informing you that the installation was completed successfully. Click
Finish to exit the installation process.

Note: In order to view the RIGS optimally, you should have your Windows display set for “Small Font.” To
check your current font setting, click your Windows Start button, then the Settings button (exact
procedures may vary depending on which version of Windows you are using). Select Control Panel. In
the Control Panel box, click the Display button. On the Display Properties screen that appears, click the
Settings tab at the top. In the left column, there is a “Font size” option:

- If the current font setting is “Small Fonts,” click Cancel, close Control Panel, and proceed.
- If the current font setting is “Large Fonts,” click the “Font Size” box and select “Small Fonts.” Click the OK

button at the bottom of the Control Panel. A dialog box is displayed, informing you that you must restart your
computer for the changes to take effect. Click Yes to restart your PC with the correct “Small Fonts” setting.

Installation Error Message

During installation, you may receive the following message:

Setup B3

' Setup cannot continue because some system files are out of date on

iy wour system. Click OK if you would hke setup to update these files for
you now. You will need to restart Windows before pou can run setup
again. Click cancel to exit setup without updating system files.

Installation Error: Files Out of Date

If you receive this message, it indicates that certain files on your system need to be updated in order to install
RIGS successfully. To update these files automatically, simply click the OK button, and reboot your PC.
Once it reboots, install RIGS (perform all procedures described at the beginning of this section -- steps 1
through 8). You should no longer receive the Files Out of Date error.
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Using the EIA-23 Reserves Information Gathering System (RIGS)

From your Windows Desktop, click the Start button, then the Programs button. Select the EIA Applications
item, and then click RIGS 2015. If this is the first time you have opened the new 2015 version of RIGS, the
following message box is initially displayed:

Initial Import ]

Would you like to start this year's submission by importing data?

This was added to remind the user to import last year’s Field data first before proceeding to add companies
or fields manually. If you wish to use this option, click Yes and follow the instructions below. If not, click No
and the RIGS Main Menu screen will be displayed - skip to page 6.

Initial Data Import from Last Year's RIGS Submission File

This is useful if you have a large number of Fields to enter manually. Importing last year’s file will
automatically enter the Field identification information for all Fields that your company reported in the
previous year, and it will move last year's Total Proved Reserves data (from Column J of the EIA-23) to this
year’'s Total Proved Reserves (Column A). If you are using the same PC for filing RIGS as you used last
year, the file to be imported should be located in the previous year’s \RIGS yyyy\data directory, where yyyy is
the four-digit previous filing year.

After you click Yes from the “Initial Import” box shown above, the following screen is displayed:

r

B3 Import File Name 5
@"\_}vl <« Local Disk (C) » RIGS2014 » Data » ~ [ %3 |[ Search Date r
Organize ¥ New folder E~ l @&
& Downloads ~ Name . Date modified Typ

= Recent Places
Temp File
s £ 2] respondent.mdb Mic
~a Libraries
¢ Documents
J‘J Music
k= Pictures
B videos
1% Computer
£, Local Disk (C)
a DATAPART1 (D) v |4 m
r
File name: respondent.mdb - !lLastYear'sData(Rgspondent.rn -
Qpen |v [ Cancel J

Import From File - Import File Name

In the bottom right field (shown above), select “Last Year's Data (Respondent.MDB)” (its location on
your hard drive depends on where you loaded the RIGS system in the previous year).
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In the “File Name” field, select last year's “Respondent.MDB” file name, containing the previous year’s
filing data.

Click the Open button. A confirmation box is displayed, informing you that the import is complete. (You may
receive an error message if the file is not in the correct format.) Once the import is finished, a message is
displayed to inform you that the import is complete. Click OK and the RIGS Main Menu is displayed. When
you click the “Select Company” option, the company or companies from last year’s filing should appear in the
“Company Selection Screen.” All Fields for which you entered data in the previous year will then appear
when you select the “View/Modify Existing Fields” on the Schedule A tab, along with the Total Proved

Reserves data for the prior year.

After completing this initial import, you are ready to enter data for the current year.



Form EIA-23 Reserves Information Gathering System (RIGS) User’s Guide February 2016

The RIGS Main Menu Screen

From your Windows Desktop, click the Start button, then the Programs button. Select the EIA
Applications item, and then click RIGS 2015, and the Main Menu Screen of RIGS is displayed, as shown

below:
{5 E1823 Electronic Filing System o ® =
| Verify Data | Form EIA-23 : Report Year 2015 | Hep W Ext |
Home ] Cover Page Part | T Cover Page Parts Il /1l ] Schedule A
) /
Click the
“Home” tab at
any time to
return to the
Main Menu
Screen

Print Form

Creste Submission Fie

Import from file

Questions or Problems? Please call 1-800-679-1470 for assistance.

Main Menu Screen

The four main options available in RIGS are accessed via this menu. They are as follows:

1) Select Company: Click this button to add a company to RIGS, select a current company for
editing, or remove a company from RIGS.

2) Print Forms: Click this button to print a copy of the current version of the active company’s
EIA-23 form.

3) Create Submission File: Click this button to generate a file containing all entered Field data, for
submission to EIA.

4) Import from File: Click this button to load prior-year Field data, or an externally-created data
file, into RIGS.

Each option is described in the sections that follow.
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Select Company

After clicking the Select Company button on the Main Menu Screen, the following Company Selection
Screen is displayed:

Com™ .ay S Hection >.~een

Select Add | Remove Company | ok
ELA 1D Number : | Lancel
Company Name : |
Please enter the six digit ID number
supplied by EIA and your company
name.

Select Company - Company Selection Screen

On this screen, there are three tabs, representing the three options available. You may select a company to
edit (Select), add a new company to RIGS (Add) or delete a company from your current list of EIA-23
companies (Remove Company).

“Select” List: This list shows the name and control number of each company for
which the respondent intends to submit EIA-23 data. Companies can be easily
added and removed from this list. Once the list is completed, the user can select
any company to edit or validate from the “Select” List.
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Add A Company
To add a company to your list of current companies, follow these procedures:
1) Click the Select Company button from the Main Menu Screen.
2) If you have not yet added any companies to RIGS, go to step 3 (the Add tab is the default tab

displayed). If you have already added one or more companies but need to install another
company, click the Add tab, as shown below:

Company Selection © .ceen

Select |.6.dd Hemove Companyl Ok

Generic Gas Cancel
Standard Gas 000001

Select Company - Add tab

3) After the Add tab is clicked, the following screen is displayed:

Company Selection Screen

Select Add I Remove Company I Ok
ElA 1D Number : Lancel
Company Name :
Please enter the six digit ID number
supplied by EIA and your company
name.

Select Company - Add
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4) The cursor should appear in the EIA ID Number box; type in the ID number of the new
company. If you do not know the company’s control number, contact the EIA at 1 (800) 879-1470
-- do not make one up!

5) Tab to the Company Name box, and type in the new company’s name.

6) Click the OK button to add the new company to your “Select” List. The Cover Page Part |

screen is displayed, and you are ready to enter data for the new company. This new company
will also be added to the “Select” List (if you wish to edit, print, or submit it at a later time).

Select a Company

To enter data for a company that you have already added to the EIA-23 respondent database, follow these
procedures:

1) Click the Select Company button from the Main Menu Screen.

2) Click the Select tab. A list of companies that have already been added is displayed, as shown
below:

Company Selection Screen

Select Is!xdd I Remove Company] Ok

010102 Cancel
Standard Gas 00000

Select Company - “Select” tab

3) Scroll down the list to locate the company you wish to edit. Once you've located the desired
company, click the company name, then click the OK button. The selected company is then
displayed in the Cover Page Part | screen, ready for data editing.



Form EIA-23 Reserves Information Gathering System (RIGS) User’s Guide February 2016

Remove Company
To remove a company from the “Select” List, follow these procedures:
1) Click the Select Company button from the Main Menu Screen.

2) Click the Remove Company tab. A list of current companies is displayed (identical to the
list displayed under the “Select” tab).

3) Scroll down the list to locate the company you wish to remove from the “Select” List, and click
the company name, then click the OK button.

4) A confirmation box is displayed, asking if you are sure you wish to delete the company. Click
the Yes button to confirm removal of the company, or No to cancel the removal process. If you
click Yes, the selected company is removed from the “Select” List, and the Remove Company
screen tab is still displayed, in case you wish to remove more companies.

Note: If you decide you removed a company by mistake, you must click on the “Add” tab and
“re-add” the deleted company, and re-enter any data for that company.

10
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Enter Data

After you have added at least one company to your “Select” List, you may begin to enter data for that
company. To begin updating company data, follow these procedures:

1) Click the Select Company box from the Main Menu Screen.
2) The default tab selection is “Select.” Single click on a company in the “Select” List box, then

click the OK button to enter data for that company. The Cover Page Part | screen is displayed, as
shown below:

([ 1823 Electronic Filing System ==

Verify Data Form EIA-23 : Report Year 2015 | Hep M Ext

Home T Cover Page Part | ] Cover Page Parts Il /1l T Schedule A

Partl: Identification

Company Hame, Address and/or Contact Information:

Company Name : lStandard Gas Primary Contact : | James Smith
Address : | 456 26th Street Phone Number : | (542)658-4562  Ext: |
City : | Anytown E-mail : | jsmith@standard.com
State: |LA  Zip:|51544 Secondary Contact : | Barry Jones
Fax Number : [(542)654-8788 Phone Number : | (588)652-4577  Ext: |

E-mail : | bjones@standard.com|

Was your company an oil and gas field operator during calendar year 2015?
" No. Complete Parts |, Il and Il but do not complete Schedule 4.
(¢ Yes. Complete Parts |, Il lll and Schedule &.

Company Status, Hame and/or Address Change or Correction:
[~ Name and address on mailing label are correct.
[T Change company name, contact person, andior mailing address as indicated above.
[~ Company was sold or merged.
[~ Company went out of business. Customer accounts taken over by another company.

Comments :
|EIA ID : 123456 Questions or Problems? Please call 1-800-879-1470 for assistance.
EIA Enter Data - Cover Page Part |
Identification
Number

SC

Su

Notes

The currently-active company’s EIA identification number is displayed constantly at the bottom of the

reen (as indicated above).

Several new identification data entry fields have been added for Report Year 2015, as circled above. In
these “Secondary Contact” information fields, you may enter the name, phone number (with extension, if
necessary), and email address for a second person within your company who can be contacted if there are
guestions about your RIGS submission, should the primary contact be unavailable. The primary contact's

pervisor may be an appropriate person to identify here.

11
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The three sections that follow describe the three screens on which data can be entered. Click on the tabs at
the top of the screen to access each: Cover Page Part |, Cover Page Parts Il/1ll, and Schedule A.

Cover Page Part |

This tabbed page is used to enter company identification information. After clicking Select Company from
the Main Menu Screen, click on a company to edit from the “Select” List. Follow the procedures below to
add/edit company identification data:

1) After selecting a company to edit, the cursor will be automatically positioned on the first input
data entry box of the Cover Page Part |. After entering or modifying identification data, you can
press the Enter or Tab key to continue to the next input data entry box. Press the Shift + Tab
key combination to move the cursor to the previous input data entry box.

2) Enter any applicable company identification information on the Cover Page Part I. In the
middle of the screen, you are asked “Was your company an oil and gas field operator during
calendar year 2015?" Click the appropriate radio button:

- If you select “No,” you only need to fill in Parts I, Il and Il in RIGS. No Schedule A
company data can be entered if “No” is selected here.

- If you select “Yes,” you must complete Parts I, Il, Il and Schedule A, which includes
Field data. If you have Schedule A data to report for the current year, you must select
“Yes” here.

Cover Page Parts Il/lI

This tabbed page is used to enter parent company information and your approval. After clicking Select
Company from the Main Menu Screen, click on a company to edit from the “Select” List. Follow the
procedures below to add/edit parent company identification data and/or approval data:

1) Click the Cover Page Parts II/lll tab at the top of the screen, as shown below:

[ E123 Electronic Filing System ol & /(3|
Form EIA-23 : Report Year 2015

( Home | CoverPagePatl | Cover PageParts i/l | Schedule A

Enter Data - Cover Page Parts Il/lll Tab
2) The Cover Page Parts II/lll tab screen is displayed. Fill in Part Il as described below:

If your company is controlled by a “parent company,” click Yes and fill in the parent
company’s name and address.

If your company is NOT controlled by a “parent company,” click No and proceed to Part
I, Approval.

3) In Part Ill, Approval, enter the name of the Contact Person and his/her title in the boxes
provided.

12
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Schedule A

This tabbed page is used to enter Field information and data. After clicking Select Company from the
Main Menu Screen, click on a company to edit from the “Select” List. Follow the procedures below to add or
delete a Field for that company, or to edit Field data:

1) Click the Schedule A tab at the top of the screen, as shown below:

‘[ E1823 Electronic Filing System o] @ (=

Form EIA-23 : Report Year 2015

( Home | CoverpagePat! |  CoverPagePatsiill | Schedule A’ I

Enter Data - Schedule A Tab

Notes: A message may appeatr, alerting you that there is no need to fill in Schedule A data, because you
have answered “No” to the question, “Was your company an oil and gas field operator during the current
survey year?” in Part . You cannot access the Schedule A Tab Screen unless you have already selected
“Yes” for that question on the Cover Page Part | tab screen.

If you have not yet entered any fields, the “Add/Delete Fields” box is displayed first, as shown on the next
page, requiring you to enter at least one field before displaying the “Schedule A Tab Screen.”

2) The Schedule A Tab Screen is displayed, as shown below:

[j EIA23 Electronic Filing System [":"_]I._E‘__
Verify Data Form EIA-23 : Report Year 2015
Home T Cover Page Part | T Cover Page Parts Il /1l T Schedule &
1. State 2. Subdiv 3. County 4.Field 5. Type
Code Code Code  Code Code 6. Field Name Add { Delete Fields
D | jo2z  |oo2210 |C | ACCIDENT

View ! Modify Existing Fields

7. Proved NonProducing Reserves -

Assoc-Dissolved  NonAssocisted Lease Candensate
a Crude Oil (Mbbl) b, Gas (MMcf) c. Gas (MMct) d. (Mbbl)
1 | | | | B.Footnote (Schedule B) [

Sort Order

9.WalerDepth:| 10.FieldDisc>weerear:[1944 11.Prospede(0ptional):|

Total Proved New Calendar  Total Prowved
Reserves Revision Rewision New Field  Resenvoirs in Year Reserves
Dec.31.2014  Increase Decrease Sales foquisitions  E i D Oid Fields  Production Dec. 31, 2015
) (B) (C) (D) (E) F) (G) (H) 0] )

~12. Crude Oil (Mbbl)
| | I l | | [ i 1

13, Associated-Dissolved Gas (MMcf)
| | [ [ [ [ [ [ | |
~14. NonAssociated Gas (MMcf)

| | [ [ [ [ [ [ [ [
~15. Lease Condensate (Mbbl)

[ [ [ [ [ [ [ [ | |

|EIAID: 123456 | Questions or Problems? Please call 1-800-§79-1470 for assistance.

Enter Data - Schedule A Tab Screen

13



Form EIA-23 Reserves Information Gathering System (RIGS) User’s Guide February 2016

In order to enter data on this screen, you must first select a Field for the company. This can be
done by one of two methods:

- Add a Field

- Modify a Field

Add a Field

If the Field that you wish to update has not yet been added for the company you've selected,
click the Add / Delete Fields button, as shown below:

Form EIA-23 : Report Year 2015

Home I Cover Page Part| T Cover Page Parts 1 /Il T Schedule A
1. State 2. Subdiv 3. County 4.Field 5. Type
Code Code Code  Code Code 6. Field Name Akt { Delets Fiekds
Mo | loza Jooz210 |c | ACCDENT
View / Modify Existing Fields

7. Proved NonProducing Reserves
Assoc-Dissolved  NonAssociated Lease Condensate

a. Crude Oil (Mbbl)  b. Gas (MMcf) c. Gas(MMcf)  d. (Mbbl)
11 | | [ | 8.Footnote (Schedule B) [~

9.Wder0ep(h:| 10.Fbsid9iscovery‘(ew:|1944 11. Prospect Name (Optional) : |

Sort Order

Tetal Proved New Calendar  Total Proved
Reserves Revision Rewision MNew Field  Reservoirs in Year Reserves
Dec. 31. 2014 Increase Decrease Sales it i Dis i Old Fields  Production Dec. 31, 2015
(A (8) (<) (o) (E) (F) (G) (H) m ]

1-12. Crude Oil (Mbbi)

I I I I I I I I p
13, Associated-Dissolved Gas (MMcf) -
I [ | [ | [ | [ | I

~14. NonAssociated Gas (MMcf) -

| | | | | | | | | |
15, Lease Condensate (Mbbi)

| | | | | [ | | | |
|EIAID:123456 | Questions or Problems? Flease call 1-800-879-1470 for assistance. |

Enter Data - Add / Delete Field Button

The following Add / Delete Field Maintenance Screen is displayed:

Add / Delete Field Maintenance Screen
Delete Field

Field Name Click here if field is not in list
Subdivision Code
County Code
Type Code

Discovery Year [oooo
Please enter the state code first to retrieve valid fields for that state

9

Enter Data - Add / Delete Field Maintenance Screen

14
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First, you must select the state in which the Field resides. You may type in the state’s
two-character code, or select from the drop-down list (as shown on the previous screen). If you
type in the state code manually, click the Retrieve Fields button (just to the right of the state code
box) to display a list of Fields for that state; if you select the state code from the drop-down list
with the mouse, the list of Fields for that state is displayed automatically.

An example of a Field List is shown below:

Add / Delete Field Maintenance Screen

Add Field Delete Field

s Stote Code [AZ_Retrieve Fieids |
,_ ‘ Field Name | Click here if fieldis not infist |
|[| | Subdivision Code [ Field [Code [Sub |[County [Code|a
, County Code [BITA PEAK 066926 APACHE 001 |
; Type Code [BLACK ROCK 068562 APACHE 001 |
il | Discovery Year [POUNDARY BUTTE EAST 083326 | |APACHE joo1 |
il DINEH-BI-KEYAH 192820 | APACHE oot |

i

|

{DRY MESA, |203664 | | APACHE oot | W
NAVAJO SPRINGS EAST 499700 APACHE 001 |

Enter Data - Field List

Note: If the Field you wish to add does NOT appear on this list, click the Click
here if field is not in list button (located to the right of the Field Name box).
The Field List disappears, and you must then type in the following information
for the new Field:

Field Name

Subdivision Code

County Code and County Name
Discovery Year

It is important to note that, with the exception of Type Code, this is the only time
you can change these Field Identification entries. After a company is added,
these data entry boxes are auto-loaded and cannot be edited. After entering the
appropriate data in the boxes listed above, click the OK button to add the Field to
the current company. Field Name is required; all other boxes can be left blank if
you're unsure what to enter (the system handles the Field Code field if you're
entering a new Field not on the list).

If the desired Field is located on the Field List (scroll up and down by clicking on the up and down
arrows along the right side of the Field List), click on that Field Name. The Field’s Field Name,
Subdivision Code, County Code and Name, Type Code and Discovery Year are automatically
filled into the Add /Delete Field Maintenance screen, as shown on the next page.

15
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Add / Delete Field Maintenance Screen

Delete Field

Stete Code [AZ_Retreve Fieids |

Field Name | 574 PEAK Click here if field\is notinlist
Subdivision Code |

Courty Code [007
Discovery Year |1956

| Please enter the state code first to retrieve valid fields for that state l

Enter Data - Field Selected

Note that Type Code is no longer shown on this screen. Type Code is now considered a
MANDATORY field, and must be selected on the Schedule A main screen after the Field has been
added.

After the desired Field’s data are displayed in the Add / Delete Field Maintenance Screen, click the OK
button, as shown above. The selected Field’s data are then displayed on the Schedule A Tab Screen, as
shown below:

=] E1823 Electronic Filing System = =
[ seve | Form EIA-23 : Report Vear 2015
Home 1 CoverPagePart| |  CoverPagePatsi/l | Schedule A

1. State 2. Subdiv 3. County 4. Field /7 5. Type o

Code Code Code Code | Code 6. Field Name Add / Delete Fields
laz | joo1  [osse2s | || [EimarEAK A

" View XISting 3
7. Proved NonProducing Reserves 2 coeiontionel 1
Assoc.DissoldCB  |Coal Bed — Sort Order

a. Crude Ol (Mbbl) b, Gas (MMc|CH  |Chalk

[ [ LP  |Low Permeabilty 8. Footnote (Schedule B) [
' SH |Shale
9.W«lerDep(h:| 10.Field DigetuN  |Unknown (0pﬁonal):|

Calendar  Tetal Proved

Total Prowed - New
Reserves Rewision Rewision New Field Reservoirs in Year Reserves
Dec. 31. 2014 Increase Decrease Sales quisiti Extensions  Discoveries  Old Fields  Production Dec, 31, 2015

() (8) (C) (D) (E) (F) (G) (H) [0} )
~12. Crude Oil (Mbbl) N

7.
l | — /I — 1 | r

13. Associated-Dissolved Gas (MMcf)
[ [ | | [ | [ [ |

14. NonAssociated Gas (MMcf) -
[ | | | | | | | [

~15. Lease Condensate (Mobl)
I [ [ [ [ [ | [ [ I

|[EIAID: 123456 | Questions or Problems? Please call 1-800-879-1470 for assistance.
Enter Data - Schedule A: Field Data

The Type Code drop-down menu is automatically displayed if the selected Field does not have a
previously selected Type Code. The first thing you must do on this screen is select a Type Code from this
drop-down menu, highlighted above. Select the description that best describes the reservoir in which the
reserves lie. Type Code options include Conventional, Coal Bed, Chalk, Low Permeability, and Shale. If
you aren’t sure about the nature of the reservoir, select Unknown.

Note that if you do not select a Type Code, and then attempt to click another tab (Home or Cover Page),
the Type Code drop-down will again be displayed, until you select one of the listed types.
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After selecting the Type Code, continue by entering the appropriate data in each box. Use the Tab (or
Enter) key to move to the next box, or use the mouse to move around the screen.

Enter Schedule A Data
Where numeric values are expected:

0 All data entry boxes must have positive values, except Calendar Year Production
(Column | for Items 12, 13, 14, and 15), which can be a negative number.

o] Enter the appropriate number, or leave the data entry box blank.
o} Use the Right Arrow key or the Left Arrow key to move within the active data entry box.
o} For Items 12, 13, 14, and 15, the following calculation is used to determine the Total

Proved Reserves (Column J):
ColumnA+B-C-D+E+F+G+H-1=1]

As you enter data into any of the columns A through I, the Total Proved Reserves field
in Column J will be auto-filled with the calculated total, using the formula above. The
four Column J data fields cannot be edited, as they are automatically calculated, as
shown below.

{7 E1A23 Electronic Filing System @ .
Verity Data Form EIA-23 : Report Vear 2015 | Hep |
f Home T Cover Page Part | ] Cover Page Parts 1 /1l ] Schedule A
1. State 2. Subdiv 3. County 4.Field 5. Type
Code Code Code Codle Code 6. Field Name Add / Delete Fields
laz | joor [oses2e [c [BmarERK
View / Modify Existing Fields
7. Proved NonProducing Reserves
Assoc-Dissolved  NonAssociated Lease Condensate Sort Ordler
a. Crude Oil (Mbb)  b. Gas (MMcT) c. Gas (MMct) d. (Mbbil)
| 500 [100 | | 8. Footnote (Schedule B) [
9.Wa‘!erDeﬂh:|12 1U_FnldDiscweerea::|1-g§_5 11_Prnm;d!¢m|e{0ptkndj:]

Total Prowed Hew Calendar  Total Prowed
R Revisi Revisi New Field  Reservoirs in Year Reserves
Dec. 31,2014 Increase Decrease Sales foquisiti Extensi Di i Oid Fields  Production Dec. 31, 2015
(A) (8) (C) (D) (B) (F) (G) (H) U] )

12. Crude Oil (Wbbl)

[100 5 |6 [7 [20 |22 [33 [ [101 153
/uls, Associated-Dissolved Gas (MMct) \

{203 [s [64 [ | | | [ [15 fos N .
_ P TeS e s ...the value in
As you enter data in any I . [ | | | | [ ! | B Column Jis
of the Ro_w 12 through - S automatically
15 data fields.... — [ | [ | | I [ [ [ calculated and
[EIA 1D : 123456 Questions or Problems? Please call 1-800-879-1470 for assistance. filled. It cannot be
edited manually by
the user.
Enter Data - Schedule A: Calculated Total Reserves
Auto-calculated data in the Column J, Total Proved Reserves, fields cannot be
changed manually by the user. Fields 12-J, 13-J, 14-J, and 15-J are read-only.
0 Click the Save button in the upper left portion of the screen to save your work at any

time.
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Delete a Field

If you wish to delete a Field from your RIGS database, click the Add/Delete Fields button.

Click the Delete Field tab (on the right of the screen) to view all Fields that have been added to the
currently-selected company. Select the company you wish to delete, then click the OK button. A

confirmation box is displayed, asking if you are sure that you wish to delete this Field. Click the Yes button
to delete the company (or No to return to the Add/Delete Field Maintenance Screen).

View/Modify Existing Fields

If you wish to view or edit data for a Field which has already been added to the currently-selected
company, click the View/Modify Existing Fields button. A list of all Fields that have been
added to the currently-selected company is displayed. Click on the Field that you wish to edit, and its

Schedule A data are displayed. Follow the data editing procedures in the “Enter Schedule A Data”
section of this document to change the data you have already entered for the selected Field.

Add a Footnote

If you wish to add a footnote (Schedule B) for any Schedule A data you enter, follow these procedures:

1) Click the Footnote button, as shown below:

[} E1823 Electronic Filing System o] B (eS|
Verify Data | Save | Form EIA-23 : Report Year 2015 | Hep f§ EBxt |
' Home ] Cover Page Part| ] Cover Page Parts 1/l ] Schedule A
1. State 2. Subdiv 3. County 4.Field 5. Type
Code Code Code Code Code 6. Field Name Add / Delete Fields
ez | Joon  Jossae [C [BimaPEaK

View [ Modify Existing Fields

7. Proved NonProducing Reserves

Assoc-Dissolved  NonAssociated  Lease Condensate Sort Order

a. Crude Oil (Mbbl)  b. Gas (MMcf) c. Gas (Mvcr) d. (Mbbl)

| 500 | 100 | | 8. Footnote (Schedule B) I‘\
B.Meroepih:hg 10_F&ethiscoveerw:|iQSB 11. Prospect Name (Optional) : | D
Total Prowed New Calendar  Total Proved

R Revish Revish New Field  Reservoirs in Year Reseves
Dec.31.2014  lncrease  Decrease Sales  Aoquisit Bdensi Di ! Old Fields  Production Dec, 31, 2015

[ (B) (C) (0) (E) (F) (G) (H) [0) )
12. Crude Ol (Mbbl)
|100 5 (6 [7 [20 [22 [33 | [101 B6

13. Associated-Dissolved Gas (MMcT)
[203 [s (84 ! [ [ [ I [15 fios

~14. NonAssocisted Gas (MMcf)
I | [ [ | | | | [ i

15. Lease Condensate (Mbbl)
[ | [ [ [ [ [ [ [ |

[EIA ID : 123456 Questions or Problems? Please call 1-800-879-1470 for assistance.

Add a Footnote - Footnote Button
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2) The Footnote box is displayed, as shown below:

2

Add | Modity | Delete

Type Item Number for which you
wish to enter a Footnote here...

tem Number (1 -15): [ qm
Column Letter (& - J) : |_‘.

...and Column Letter here...

...and type Footnote in this area.

Add a Footnote - Footnote Box
3) In the Footnote box, type in the ltem Number and Column Letter (if applicable) into

the appropriate boxes, then type in the footnote in the area at the bottom of the box, as shown
above.

For example, if you wish to enter a footnote for NonAssociated Gas - Sales, type “14” in the Iltem
Number box (for NonAssociated Gas) and “D” in the Column Letter box (for Sales). This
indicates that the footnote applies to that specific data entry box.

4) After typing in the desired footnote, click the OK button. The system retains the footnote and
it will appear on the hard copy when the “Print Form” option is used.

Modify a Footnote
If you wish to alter a footnote after entering it, follow these procedures:

1) Click the Footnote button on the main screen. The Footnote box is displayed, and footnotes
can be changed by clicking the Modify tab, as shown below:

OK

Click the Modify tab to change
an existing footnote.

Footnote Box - Modify
Footnotes
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2) A list of all footnotes is displayed (by Item Number and Column Letter); click on the footnote
you wish to edit. The footnote text will appear in the area at the bottom of the Footnote Box, and
you may edit it as you wish. Be sure to click the OK button when you have completed editing the

footnote, to save your changes.

Delete a Footnote

If you wish to delete a footnote, click the Delete tab (to the right of the Modify tab shown above), and

select the footnote you wish to delete from the list that is displayed.
selected footnote.

Verify Data

Click the OK button to delete the

After you have entered your data for the Field (or Fields), it is recommended that you verify the
form data. RIGS uses numerous edit checks to assist you in making sure the data you enter are
correct. To run these edit checks, click the Verify Data button in the upper left corner of the

screen, as shown below:

=9

[} £1423 Electronic Filing System ® (==
[verify Data) Save 0 Report Year 20 Help Exit
/ Home ] Cover Page Part | ] Cover Page Parts Il /ll T Schedule A
1. State 2. Subdiv 3. County 4.Field 5. Type
Code Code Code Code Code 6. Field Name Add { Delete Fields
jaz | Joor  |oses2e | cC [BiITa PEAK
View / Modify Existing Fields
7. Proved NonProducing Reserves
AssocDissolved  NonAssocisted  Lease Condensate Sort Order
a. Crude Oil (Mbbl)  b. Gas (MMcf) c. Gas (MMcf) d. (Mbbl)
| 500 | 100 8. Footnote (Schedule B) [
Q.Wderl')epm:hz 10.FieldD|'scweerear:|1g§5 11.Prospec1Nsm(0pﬁonal):[
Total Proved HNew Calendar  Total Prowed
Reserves Revision Rewvision New Field  Reservoirs in Year Reserves
Dec. 31. 2014 Increase Decrease Sales 5t B i Di 0id Fields Production Dec. 31, 2015
(] (B) (C) (0) (E) (F) (G) (H) [0] )
12. Crude Oil (Mikl)
100 5 G [7 [20 |22 |33 [ [101 b6
13. Associated-Dissolved Gas (MMcf)
| 203 |5 |84 | | | | [ [15 fiog
14. NonAssociated Gas (MMc)
| | | [ | | | | | 0
15. Lease Condensate (Mbbi)
| | [ | [ | | | | |
|EIA 1D : 123456 Questions or Problems? Please call 1-800-879-1470 for assistance. [

Verify Data - Verify Form Button

1) A dialog box appears, asking if you want to verify data for the selected Field only, or for all

Fields. This box is shown below:

veriicaton g

l.-"_‘“ ) Do you want to verify this field only?
. 4 (Yes - Verifies this field only)
{No - Verfies all fields)

_ e ([ e |

Verify Data - Verification Dialog Box
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If you wish to only verify data for the Field currently selected, click Yes.
If you wish to verify data for all Fields you've entered, click No.

If you do not wish to verify any Fields at this time, click Cancel to return to the Schedule
A Tab Screen.

2) After running the Verify Data option, progress messages are displayed, indicating that

Fields are being validated. Once validation is completed, you may receive a message stating
that no errors have been detected. In that instance, your data are clean and you may proceed to
send your filing to EIA. However, if errors are found, the following screen is displayed:

= E1A23 Electronic Filing System o] @ =
Field |BITAPEAK St |az Sub | Cnty [001 Type [

Problem : ERROR : NonProducing Reserves of Crude Oil must be <= Ending Reserves of Crude Oil.

Footnote: |

| Next Edit Restart Edits Done |

| a. Crude Oil (Mbbl)  b. as(MMC) . Gas(MMch)  d. (Mobl))
Il fs00] [100 [o [o |  8.Footnote (ScheduleB) [~

Q,WaterDeﬁh:hz 10,Fie|dDiswveerw:|1555 11,PfcspedNNre(0p(ionea|]:[

Total Proved New Calendar  Total Proved
Reserves Revision Rewvision New Field Reservoirs in Year Reserves
Dec. 31. 2014 |ncrease Decrease Sales #ocuisitions  Extensions  Discoveries  Old Fields  Production Dec. 31, 2015
) (8) (C) (0) (5] (F) (G) (H) 0] )
~12. Crude Oil (Mbbl)
1100 5 |6 |7 |20 [22 [33 |0 [101 b6
~13. Associated-Dissolved Gas (MMcf)
| 203 |5 | 84 ] [ [ [ [0 [15 fiog
14. NonAssociated Gas (MMcf)
fo (o ] (o [0 [0 [0 [0 [0 o
~15. Lease Condensate (Mbbl)
o ] ] |0 ] o |0 o |0 1]
[EIAID:123356 |  Questions or Problems? Please call 1-800-§79-1470 for assistance. [

Verify Data - Validation Screen

3) The top portion of the screen shows the results of the validation. See the explanation
on the next page for details on navigating through the validation process.
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i EIAZ23 Electronic Filing System =] B |
Field |BITAPEAK St |AZ Sub | Cnty 007 Type[TH

Problem : ERROR : NonProducing Reserves of Crude Oil must be <= Ending Reserves of Crude Oil.

Restart Edts | Done [

Verify Data - Navigate

At the top of the screen, the Field Name is listed, along with the State Code, Subdivision Code,
County and Type Code.

Next, the Problem is shown. The reason that the system flagged the data is given, and the data
value in error is highlighted in the Field data area (the lower part of the screen). Thus, you can
easily correct the errant data.

If flagged data are acceptable to you, you can enter an explanation for the discrepancy in the
Footnote box. This footnote will automatically be saved to the Item and Column which have been
flagged. For example, if an error is flagged for the data in Item 12, Column A, you may enter a
Footnote when the verification process displays Iltem 12, Column A’s problem. The new
Footnote will then be “attached” to Item 12, Column A, when you return to the main data entry
portion of the Schedule A Tab Screen. For further details, see the “Add a Footnote” section.

Along the bottom of the Verify Form - Navigation screen (shown above) are four buttons:

Previous Edit: Click this button to return to the edit prior to the one currently displayed.
Next Edit: Click this button to display the next edit discovered during verification.

Restart Edits: Click this button to restart the verification process. The Verification
Dialog Box is displayed -- follow instructions earlier in this section to run the Verify Form
process. “Restart edits” is available in case you wish to make changes to Field data
while the “Verify Form - Navigation” screen (shown above) is displayed (Field data is still
viewable and editable in the lower portion of the screen), and you want to verify these
new updates.

Done: Click this button when you are finished reviewing the edits; the Verify Form screen
disappears, and the complete Schedule A Tab Screen is re-displayed.
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There are two tabs that can be clicked while using the Verify Form option:

Navigate: The default option. Click this tab to scroll through the discovered edits using
the features described above.

List: Click this tab to display the following:

i@ EIA23 Electronic Filing System H =] B3

ID: 094821 RIGS Error Re‘f;ﬂ

»

Print | Done [

Verify Data - List

The List option displays the first page of the printable version of the “RIGS Error Report,” a list of
all edits discovered for the current company’s Fields.

Use the horizontal and vertical scroll bars along the right side of the List box to view the first page
of the report.

Click the Print button to print the full report.

Click the Done button to close the Verification window; the Schedule A Tab Screen is re-
displayed.
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Sort Order

This option can be used to set the order that the Fields will be listed when you use any of the Field Selection
options (Add/Delete Fields or View/Modify Existing Fields). This is especially useful if your company reports

for a large number of Fields.

To change the default Field sort order (State, Subdivision, County Name, Field Name, Type Code), click the

Sort Order button on the Schedule A Tab Screen, as shown below:

5 E1823 Electronic Filing System o] & =
Verify Data Save Form EIA-23 : Report Year 2015 Help Exit
Home | CoverPagePatl |  CoverPagePatsiim | Schedule A

1. State 2. Subdiv 3. County 4.Field 5. Type

Code Code Code Code Code 6. Field Name

Add / Delete Fields

laz | Joon  |oseg2s |C | BITA PEAK

View f Modify Existing Fields

7. Proved NonProducing Reserves

8. Footnote (Schedule B) [

Assoc-Dissolved  NonAssociated Lease Condensate | i 2900 KTEE
a. Crude Oil (MbbD) b, Gas (MMcf) c. Gas (MMcf) d. (Mbbl)
| 500 /100 lo [o

9. Water Depth : | 12 10. Field Discovery Year :| 1956 11.Prospect Nm(Optionel]:[

Total Proved New
Reserves Rewvision Revision

Calendar
New Field  Reservoirs in Year

Total Proved
Reserves

'EIA ID : 123456

Dec. 31. 2014 Increase Decrease Sales Acquisitions  Extensions  Discoveries Ol Fields  Production Dec. 31, 2015
(A (B) (C) (0) (B (F) (G) (H) (1) )
12. Crude Oil (Mbhl) -
{100 5 I3 |7 |20 [22 |33 o (101 B6
-13. Associated-Dissolved Gas (MMcf)
[203 (5 [84 [o (o [0 (o (o |15 hoa
14. NonAssociated Gas (MMcf)
] ] o |0 o o ] o o 0
15. Lease Condensate (Mbhl)
[0 [0 [0 [0 [0 [o [o [o [o 1]

Sort Order - Sort Order Button

The following Specify Sort Order box is displayed:

i, Specify Sort Order [ X | I

1. Highlight entry in List
2. Use Arrows to move entries between lists

Source Fields Sort Order

OK

Cancel

SubDivision
County 4
Field Name »
Type Code

Sort Order - Specify Sort Order Box

Click on the Source Field name that you wish to use as the primary sorting method, then click the uppermost
green arrow to move that source Field into the “Sort Order” box. Continue selecting Source Field names to
set your secondary sorting methods, clicking the green > button to move the Source Field to the Sort Order

list.
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- Click the green < button to move source Fields from the Sort Order box back to the Source Field
box.

- Click the green >> button to move all Source Fields to the Sort Order box.

- Click the green << button to move all Source Fields from the Sort Order box back to the Source
Field box.

After you have selected the Sort Order that you wish to retain, click the OK button. A message box appears,
stating that your new sort order has been saved as the default sort order.

Example: You can use the Sort Order option to change to the following default sort order:

County Name, Subdivision, State, Type Code, Field Name.
Any time you select Add/Delete Fields or View/Modify Existing Fields, the Fields listed will be sorted initially
by County Name. All Fields with the same County Name will then be sorted by Subdivision. If there are

Fields that have the same County Name and Subdivision, they will be sorted by State, and so on. You can
change your default sort order anytime by using the Sort Order option again.
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Print Form
The Print Form function is used to print out a hard copy of the EIA-23 Form. This can be done as follows:

1) From the Main Menu Screen (click the Home tab if one of the other tabs is currently displayed),
click the Print Form button. The following Print Selection Screen is displayed:

Company Selection Screen

Select | Add | Remove Company | ok |

Standard Gas 23
/ WILDCAT 999001 |

Select Company
to print

Print Form - Print Selection Screen

2) On the left side of the Print Selection Screen, a list is displayecl, showing all companies
currently entered in RIGS. Select the company for which you wish to print the form (as shown
above).

3) If the company’s filing is a Resubmission, click the Resubmission box (as shown above). If the
Resubmission box is checked, the printed Cover Sheet of the Form EIA-23 will show an X in the
“Resubmission?” box, found in the top right corner of the form.

4) Click the OK button to display the Print Preview screen, as shown on the following page.
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B Forml

View Report

Header Page

Schedule &
Schedule B
Error Report
State Totals

Sort Options

Schedule &
Schedule B

_X@IBS"/.’ v[_{(l 1 ofl > )

Preview |

ANNUAL SURVEY OF DO

U.5. DEPARTMENT OF ENERGY OME No. 1905 08T
ENERGY INFORMATION AD MINISTRATON Bplmkn bak: TO1NE
Wasihats, D C. 20585 erdon N o NSO

FORM EIA-23L
REPORT YEAR 2015

MESTIC OIL AND GAS RESERVES

iz renoe | mardakoy urder e Federal Eremv,
- g corddenbaiy o i akon ad =

CEmin 1 O SnchnsuEmeny

PART LIDINTIFICATION

At of 157 ol S3T75. For e oroukk b siend
Sechore Wil ard Willed e Ireihucbone Ih' I:I

Compiet and relum by Mag 2, 0 b

At Form BA22

ar
Fan b :(202)628-107@ (& TH: Form B..23)

il & OacBurwy Eld Opemake 1D Code: 128464
U.8. Departmento fEnergy, BA pe
Bn Frankiin Bhior Company Name: gbndard Oac
PO Bos27e Sreelor Posl OMice Bon: 468 23th Btoet
vadingbn, OC 20044-@79
Cliy,Ebke ,Zip Code: anzern la  6E1644

1. Contact nformation fosrsan masrimowlsapesble sbaur
the reparied dae)
ceonlac Jamec Bmith
Phore Mumber: (642) 862 - 4682 Exl:
Fae Number: (642) 864 - 2733
Emalxdress: Jemih@cbndard.oom

2. ‘AQ0 your company an oll and ga Neld operator during
calendar ;ear 20157 /See definition of an apsramr, pags 1)

) [] wo...compie con liems 3 hrough 1 ¢ below and redrn
he pme.
] D Yes..Compk k he aliached vorm.

3. Compan; Status, Name, andior addre ns Changs or Comecion: C heck appropriate box.)

Name ard adress on maing lael ae corre cl.
Change compary name , conidcl person, and for mAing address as Ird i kd 2 cue,

Company was sold b, o merged wih, compary enkred below,
Company wenl cul of buglness . Cusbmer accounls ke nouer by Somparny enlered below .

4. Change Compan; Name, Addre s andlor Contactinto
Company Name: ]
Sreelor Posl OMice Box: o
Clly, Sk, Zip Code: []
Conlacl Person:
Prone Number:

mationto:

Fax Number E-mal Address

Print Form - Print Preview Screen

5) The Header Page is the default page displayed when the Print Preview Screen appears. You
may view any of the parts of the form of the selected company by clicking the buttons along the
left side of the screen:

Header Page: The first page of the Form EIA-23, showing Part I: Identification; Part I,
Parent Company Identification; and Part Ill, Approval. This page contains no oil and gas
data, only company identification information.

Schedule A: The second page of the Form EIA-23, showing all Field oil and gas data

entered for the selected company. Click the Sort Options - Schedule A button (below the
five Print Preview buttons) to set the sort order in which the Fields will be displayed and
printed.

Schedule B: This page(s) displays all footnotes entered in RIGS for the selected
company. Click the Sort Options - Schedule B button to set the sort order in which the
footnote information will be displayed and printed.

Error Report: The RIGS Error Report, which is the same validation report that is run by
clicking the Verify Data button.

State Totals: This page will display the totals for each state for which you have entered a
Field.
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6) After previewing the forms as you wish on the screen, click
below) to Print the desired form(s).

the Print button (as shown

-

=

3 Forml o [@
o < &R S]] Sl o
Preview
View Report - - =
Click this U.S. DEPARTMENT OF ENERGY OB Ko, 150500857
icon to ENERGY INFORMATON ADMINISTRATION Bgiakn dak: 131ZN6
Header Page _ Waskhqoy, D C. 20585 erdonNo: S0
print
Schedule A ANNUAL SURVEY OF DOMESTIC OIL AND GAS RESERVES
FORM EIA-23L
Schedule B REPORT YEAR 2015

Print Form - Print Button

The following “Print Form” box is displayed.

T S~ |

Microsoft XPS Document Writer
— Forms to Print

From:
[V CoverSheet |i 39

[~ Schedule A [i
[~ Footnotes |

[~ Enors [i 39
[~ State Totals [i 333

(7] \':'\ @© w ;‘

Print Form Box

7) You may select any or all parts of the form to print. The default form to be printed is the form
that is currently selected on the Print Preview Screen. However, you may select any or all forms
to print from this screen, and you may also dictate which page numbers of each form that you
wish to print, by typing in the desired page numbers in the “From” and “To” boxes. You may also

change your printer setup by clicking the Printer Setup button.

8) After selecting the form(s) you wish to print, click the OK button. The form(s) that you selected

(in # 7 above) is then sent to your printer.

9) The Print Preview Screen is re-displayed. Click the Exit button in the upper left corner of the

screen to return to the RIGS Main Menu.
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Create Submission File

After entering and validating all companies’ Field data for which you are responsible, you must submit your
final data to EIA. There are several methods of sending your data to EIA:

1) Create a single file (containing all respondent companies’ data that you've added or updated),
to submit to EIA via Secure File Transfer,

2) Create a single file (containing all respondent companies’ data that you’'ve added or updated),
to e-mail to EIA,

3) Print the completed EIA-23 Form (see the “Print Form” section of this guide) and mail or fax
the form to EIA (the EIA mailing address can be found at the end of this section and on the form
itself; the EIA fax number is (202) 586-1076).

To create a file to send via Secure File Transfer, follow these procedures:

1) From the Main Menu Screen, click the Create Submission File button. If you are attempting
to submit data for more than one company, the following Select IDs to Submit box is displayed:

. Select IDs to Submit E3 I

1. Highlight entry in List
2. Use Arrows to move ertries between lists

Source IDs IDs to Submit Cancel

933001 L‘

4

»»

44

OK

Create Submission File - Select IDs

NOTE: When you click the Create Submission File button, all Field data you have entered in RIGS are run
through the validation process. If a validation error is found, a “Data Failed” box appears, informing you
that a validation check has discovered a potential error in your data. Follow the instructions in the “Data
Failed” box to either correct the data or proceed with data submission (a validation report will automatically
be printed if you elect to continue). See the “Verify Data” section for more details.

2) This gives you the option of submitting companies separately, if you wish. From the left column of
“Source IDs,” click on the Company ID(s) that you wish to submit - hold down the Shift key to select
multiple IDs - and click the top green arrow to move the selected companies into the IDs to Submit
column. Move the IDs back and forth as necessary using the and arrows. To move all
companies from one column to the other, use the and 44 arrows.

After filling the IDs to Submit field with the desired companies, click the OK button to continue the
submission process.
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The “Send Submission file to EIA” box is displayed:

w. Send Submission file to EIA [_ (O] X]

Select method to send
{* Create a file to be submitted via Secure File Transfer
(" Create a file that can be e-mailed to EIA

[~ Resubmission

Secure File Transfer : A website run by EIA that allows
you to submit the file generated by this program to EI&
in & secure mode through your internet browser.

The EIA-23 survey form may be submitted to the EIA by
mail, fax, Secure File Transfer or e-mail. Should you
choose to submit your data via e-mail, we must advise
you that e-mail is an insecure means of transmission
because the data are not encrypted and there is some
possihility that yvour data could be compromised. In
your first e-mail transmission, please indicate that you
are aware of this possibilty, however remote, and
accept responsibilty should it happen.

Create Submission File - Select Method

3) Click the first option, Create a file to be submitted via Secure File Transfer (SFT). Also, if the
filing you are sending is a resubmission, click the "Resubmission" box in the bottom left corner.

4) Click the OK button. A message is displayed, describing the process for submitting via SFT.
You have two options: a) Allow RIGS to try to open your web browser to the SFT page on EIA’s
web site, and commence the submission process from there; or b) Create the submission file
and open your web browser on your own, copying the SFT web address and submitting from
there. As the message states, the file containing your company data can be found at:

C:\RIGS 2015\RIGSXXXXXX.DAT

[where C:\RIGS 2015 is the directory to which you installed RIGS; if you opted to change
from the default installation directory during the install process, the file will be copied to
whatever drive/directory to which RIGS was installed]

[where XXXXXX is the company control number]

All companies that you have added to RIGS are found in a single file.
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5) To allow RIGS to attempt to open your web browser to the EIA SFT site, click Yes when the
following message is displayed.

‘Secure File Transfer =

o You have chosen Secure File Transfer.
The file you will need to upload is called
==> C\RIGS 2015\RIGS123456.dat <==

The website address is
https://signon.eia.doe.goviupload/noticecog.jsp

¥ you would kke the program to attempt to bning up your
browser
with the website, Click “Yes’, otheraise, Click "No'.
¥ you click Yes', the file name and locastion wall be shown st the
bottom of
the Rigs Main Menu screen after your browser is open, for
reference.

No

Secure File Transfer — Dialog Box

Your Internet browser should open, and the SFT “Notice to Users” should be displayed, as
shown below:

{= User Notification - Windows Internet Explorer

J& - [T doe00v @ %) % & Bk
Fle Edt Yew Favortes Tooks Help

i Favorkes | 5 & * B FreeHotmal £ -

|58 | <. User Notfication x| Miov B L0 s - Page~ Sefety- Took~ -

EIA Secure File Transfer

This is a Federal computer system and is the property of the United States Govemment. Users have no
explicit or implicit expectation of priacy

With the ption of indrduall data or il d exclusively for

purposes under a pledge of fi.e data d frem discl by the Confi

Infarmation Protection and Statistical Efficiency Act of 2002, Public Law 107-347). in accordance with
applicable ‘aw any use of this system and all files on this sysiem may be intercepted. monitored
recorded, copied, audited. inspected and disclosed to authonzed site. Depaniment of Energy. and law

enforcement personnel. as well as authorized officials of other agencies both domestic and foreign. By
using this system, the user to lawful i itoring, n ding. copying. auditing
inspection, and disclosure at the discretion of d site or Depart of Energy p ‘

Unauthorized or improper use of this system may result in administrative disciplinary action and cil
and/or criminal penalties. By continuing to use this system you indicate your awareness of and consent
to these tems and conditions of use. CLOSE THIS WINDOW if you do not agree to the conditions

loore I i & Local intranet T ia - Rioow -

Secure File Transfer — Web Site

If you do not want RIGS to open your browser, click No on the SFT message box and print
the instructions when the “Print” box is displayed. Open your Internet browser. Type in the
SFT site address (https://signon.eia.doe.gov/upload/noticeood.jsp); the “Notice to Users” is
displayed, as shown above.
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If you accept the conditions, click the Accept button. The main SFT screenis displayed, as
shown below:

(= Secure File Transfer System - Windows Internet Explorer

@ v [t doe.gav wal At R
Ele Edt View Fgvortes Tooks Help
i Favorkes | 5 8 = @ Freeotmsl 2

<" Sacure Fis Transfer System fi- B " g v Page- Safety - Took - -

e@ U.S. Energy Information
Administration

* Required Field

® Contact Information

MNamg Company

@ File(s) lo be transferred
Press |
atime

bufton 1o select afie from your system. Upto &
nly Dat (dat), Excal (xs). Excal 2007 (xdsx) file

n be transtemed at

7 Contact EI4's technical suppont at 202-585-8950 or e-mail us 3

% Local intranst fa = Hiow -

Enter your Contact Information in the appropriate fields at the top of the screen. In the “File
1" field, type in the name of the submission file that has been created by RIGS, located here:
“C:\RIGS 2015\RIGSXXXXXX.DAT.” You may use the Browse button to locate the file.

NOTE: The file name and location (on your hard drive or network drive, depending on where you installed
RIGS) can be seen at the bottom of the RIGS Main Menu screen after you click Yes on the Secure File
Transfer message box to open your browser. Use the Alt-Tab key combination to bring RIGS back to the
foreground of your Desktop. The filename is shown at the bottom of the screen as shown below:

"1} E1A23 Electranic Filing System = & s
D EETE Farm E1A.23 1 Report Year 2015 | _teo |
T ] Cover Page Part | 1 Cover Poge Pads 1./ ] Schedule A

File To Send to EIA : ==> C:RIGS 2016 Feb Adat <=m

When you click on any Main Menu item, this message will revert back to showing the “Questions or
problems?” phone number information.
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When you are finished filling in all the required information, the SFT screen should look
similar to this sample screen:

(= Secure File Transfer System - Windaws Internet Explorer

(€ ISP dos.gov s i fheate. a8l 2=
Ele Gt Yew Fgeortes Jook  Help

i Favortes | g @8 = @ Freetomal B

£, Secure Fie Trarafer System BB | gm - Pages Safety+ Took+ b+

-fj U.S. Energy Information
el a Administration
* Required Fisld
® Contact information

Name: | James Smith

*Email. | jsmim@standard.com

@ File{s) to be transtermed

Press the Bi Ted at
*Filg 1! [CORIGS 2011RIGSI00001 DAT

Fite 2 [T

File 3 o)

Fiba 5 Bowte

(Resa)
Tranglet
ntact E14's chnical suppod at 202-585-8559 ore-mad us o
Do % Local intranet fav Wuoow -

Secure File Transfer — Filled In Screen

Click the “Submit” button and your RIGS filing will be sent to EIA. A confirmation screen is
displayed, alerting you that the submission was successful.

Use the Alt-Tab key combination to switch back to RIGS. The Main Menu should be shown; you can exit the
program; after you submit via SFT, your filing is now complete.
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To create a file to e-mail to EIA, follow these procedures:

1) From the RIGS Main Menu screen, click the Create Submission Form button. A box is
displayed, from which you can select the method by which you intend to send your data.

2) Click the second option, Create a file that can be e-mailed to EIA. Also, if the filing you
are sending is a resubmission, click the “Resubmission” box in the bottom left corner.

NOTE: If you have entered data for more than one Company ID, a “Select IDs to Submit” box is
displayed. See Step 3 of the previous section ("create a file to send via Secure File Transfer”) for

an explanation of this process.

3) Click the OK button.

The following screen is displayed, describing the process for e-mailing the data:

-

Rigs

Send TO: 00G.Surveys@EIA.GOV
Subject: RIGS

Text Message: The company inclu

Thank You!

Please email EL& with the following:

File to ATTACH: The data foryour company is included in the file

==3> C:\RIGS 2015 \RIGS123456.dat <==

These instructions will print out after pressing the OK button

= o

ded is 1234560000

Create Submission F

As the message states, you must manually

OOG.Surveys@eia.gov

ile - E-Mail Instructions

send the newly generated file to EIA at:

The file containing your company data can be found at:

C:\RIGS 2015\RIGSXXXXXX.DAT

[where C:\RIGS 2015 is the directory to which you installed RIGS; if you opted to change

from the default installation director
whatever drive/directory to which R

y during the install process, the file will be copied to
IGS was installed]

[where XXXXXX is the company control number]

All companies listed on the message screen are found in a single file.
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4) After you click the OK button from the e-mail message screen, the Print screen box is
displayed:

- Click OK to print the instructions for e-mailing your data, or

- Click Cancel to return to the Main Menu Screen.

IMPORTANT!
Remember, you must attach the described data file to an e-mail message addressed to:
OOG.Surveys@eia.gov
using your e-mail system. RIGS will not automatically e-mail the newly-generated data file to EIA! You
must attach the file to an e-mail and send it to EIA using your PC’s e-mail software (MS Outlook, etc.).

For an explanation of e-mail security concerns, see the note in the “Send Data to EIA” box on the
previous page.
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Import From File

There are three types of File Importing available within RIGS. These are:

1. Import last year's data from the RIGS MS Access file
2. Import current year’s data from a text file
3. Import Schedule A data from an Excel file

Import last year's data from the RIGS MS Access file

This is useful if you have a large number of Fields to enter manually. Importing last year’s file will
automatically enter the Field identification information for all Fields that your company reported in the
previous year, and it will move last year’s Total Proved Reserves data (from Column J of the EIA-23) to this
year's Total Proved Reserves (Column A). If you are using the same PC for filing RIGS as you used last
year, the file to be imported should be located in the previous year's \RIGS yyyy\data directory, where yyyy is
the four-digit previous filing year.

To import last year’s data file into RIGS, follow these procedures:

1) From the Main Menu Screen, click on the Import from File button. The following screen
is displayed:

-
B3 Import File Name |

@'Qvl « LocalDisk (C)) » RIGS2014 » Data » v | 49 ||| Search Date 3

Organize v New folder =~ O @&

& Downloads *  Name Date modified Typ

= Recent Places ; i .
Temp 2/10/2016 3:24 PM File

@J respondent.mdb 2/10/2016 3:24 PM Mic

m

4 Libraries
| Documents
&' Music
&=/ Pictures
B videos

/& Computer
£ Local Disk (C)
ca DATAPARTL (D) - |74 1 3

|
File name: respondent.mdb - [Last\’ear's Data{Respondent.m = |

[ Open |v| [ Cancel

Import From File - Import File Name

2) In the bottom right field (just above the Open and Cancel buttons), select “Last Year's Data
(Respondent.MDB)” (its location on your hard drive depends on where you loaded the RIGS
system in the previous year).

3) In the “File Name” field, select last year's “Respondent.MDB” file name, containing the previous
year’s filing data.

4) Click the Open button. A confirmation box is displayed, informing you that the import is complete.
(You may receive an error message if the file is not in the correct format.) Once the import is
finished, a message is displayed to inform you that the import is complete. All Fields for which you
entered data in the previous year will then appear when you select the “View/Modify Existing Fields”
on the Schedule A tab, along with the Total Proved Reserves data for the prior year.

36



Form EIA-23 Reserves Information Gathering System (RIGS) User’s Guide February 2016

Import current year’s data

Some companies that maintain a large amount of data keep their own EIA-23 data file up-to-date throughout
the year in a text file. If you have such a file, you can load it into RIGS and avoid having to enter your data
manually. The three types of file(s) to be imported must follow the format below:

Schedule A Data: These data are identified by the Record Type “A.” Data recorded as “Field
Data” on the Form EIA-23 are listed in this format.

Company Data: This file contains company identification information. These data are identified
by the Record Type “C.”

Footnote Data: This file contains all footnotes entered. These data are identified by the Record
Type “F.”

For detailed descriptions of each of these three types of import files, see Appendix A, “Import File Layouts.”

To view a Form EIA-23 facsimile, showing Data Cell Names for Company Data Files and Schedule A Data
Files, see Appendix B, “Data Cell Codes.”

Valid State codes, used in Schedule A Data Files and Footnote Data Files, are listed in Appendix C, “State
Abbreviation and Geographic Subdivision Codes.”

To import any of the three data files containing current year data into RIGS, follow these procedures:

1) From the Main Menu Screen, click on the Import from File button. The following screen

is displayed:

P >
B3 Import File Name @
Q\_) [1 « RIGS2013 + Data ~ [ 44 |[ Search Data o

Organize v New folder =~ O @
& Downloads *  Name i Date modified Typ
| Recent Place; 5
Temp 2/3/2015 2:43 PM I
4 Libraries 1
¢! Documents
& Music

b= Pictures
B videos
1 Computer
&, Local Disk (C)
s DATAPARTL (D:) - 4 i

File name: - @mntﬂqﬂng_\"ﬂfg.@_ 'B
[_ Open H | Cancel |

Import From File - Import File Name

2) In the bottom right field, select “Current Reporting Year (*.txt)” (its location on your hard
drive depends on where you store your company data).

3) Select the file name that is to be imported, and click the OK (or Open) button. A confirmation
box is displayed, informing you that the import is complete.

Note: You may receive a message informing you that the data file you are attempting to import is
invalid. Check the format of the data file you are using; it must match the format described in
Appendix A, “Import File Formats.”
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Import Schedule A data from an Excel file

This feature allows the user to import Schedule A data from an Excel spreadsheet, assuming that it is in the
correct format. The format of the spreadsheet is shown in Appendix A, Import File Formats. You may
choose to add the company or companies for which you are importing data before performing the Schedule
A Excel import, or the import process will add the company/companies for you. Companies added via the
Schedule A import will appear with no Company ldentification information on "Cover Page Part I"; you must
add that information (including Company Name) after the import. However, if the companies have already
been added to RIGS, the Schedule A Excel import will simply add the Field information from the spreadsheet
to the existing company (or companies), as identified by the six-digit ID shown in the first column of the
imported Excel spreadsheet. See Appendix A, “Import File Formats,” for more information about the specific

format of the Excel file.

To import Schedule A data into RIGS via an Excel spreadsheet, follow these procedures:

1) From the Main Menu Screen, click on the Import from File button. The following screen

is displayed:
B3 Import File Name
QQ [\ « RIGS2013 » Dats » ~ [ 43 || search Data p
Organize « New folder = 1l @
& Downloads

m| »

= Recent Places
Temp

4 Libraries

¢ Documents

o Music
= Pictures
B videos
‘B Computer
£L Local Disk (C)
a DATAPART1 (D:) - ¢ it /
File name: +  [Schedule & Only from Excel(*x] ~|
QOpen |v r Cancel

Import From File - Import File Name

2) In the bottom right field, select “Schedule A Only from Excel (*.xls),” as shown above (its
location on your hard drive will vary depending on where you store your RIGS XLS file).

3) Select the .XLS file name that is to be imported ("Respondent.xls” in the sample above), and
click the OK (or Open) button. A confirmation box is displayed, informing you that the import is
complete.

4) When you click Select Company from the Main Menu, you should see the ID number of the
company for which you have imported data via Excel. Click on the company and you can add a
Company Name on the “Cover Page Part I” tab. Your newly-imported data will appear in the
“Schedule A” tab - click View/Modify Existing Fields to see your Field data.

Note: When performing the import, you may receive a message informing you that the data file
you are attempting to import is invalid. Check the format of the data file you are using; it must
match the format described in Appendix A, “Import File Formats.”

Note: When prior year data are loaded into Columns A through J, incorrect values in Column J
will be automatically recalculated as soon as you begin entering data into any of the data entry
fields for that Field. As you enter data into Columns B through I, Column J will adjust
automatically, to ensure that the calculated Total Proved Reserves for the current year is correct.
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Help

To get information about the various functions available within RIGS, you may click the Help button (in the
upper right corner of the screen) at any time, as shown below. The Help button opens this “RIGS User’s
Guide” in your Internet browser, at http://www.eia.gov/survey/form/eia_23I/RIGS Users_Guide.pdf.

Help

1=} E1823 Electronic Filing System £ o=
0 : Repo o L} T::’!’:.@D-__‘j EXH

Home ] Cover Page Part | T Cover Page Parts Il £l ] Schedule A

Exit

Energy Information Administration

Select Company
Print Form
Create Submission File

Import from file

Questions or Problems? Please call 1-800-879-1470 for assistance.

Help / Exit

Exit

To exit RIGS, click on the Exit button in the upper right corner of the screen, as shown above.
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Appendix A - Import File Layouts - Part I: Current Year Text File Format

There are three types of TXT records that can be imported into the EIA-23 system when importing current year’s data:

1)Schedule A Data
2)Company Level Data
3)Footnote Data

Each is described below:

1) Schedule A Data: These data are identified by the Record Type “A”. Data recorded as “Field Data” on the Form EIA-23 are listed in this

format. Each record consists of the following:

Field name Type of data # of Description Examples
characters
RECORD Alpha-numeric | 1 Identifies the record as Schedule A data A
TYPE
COMPANY ID Numeric 6 ElA-supplied identification number 123456
STATE CODE Alpha-numeric | 2 Identifies the state to which data apply TX, AL
SUBDIVISION Alpha-numeric | 2 Identifies the subdivision of the state to which data 00 shall represent the subdivision for all federal
CODE apply offshore, and 05 shall represent the subdivision for all
state offshore.* A blank shall be one of the choices on
the list (some states do not have subdivisions).
FIPS COUNTY | Numeric 3 Identifies the county to which data apply 995 shall represent the county for all Federal Offshore,
CODE State Offshore is represented by 990.
FIELD CODE Alpha-numeric | 6 Identifies the field to which data apply. For a given 456789
state and county and operator, a duplicate field code
shall not be allowed. Each Field code is made unique
by the use of state and county.
TYPE CODE Alpha-numeric | 5 Identifies the type of reservoir. These include C, CB, CH, LP, SH, UN
(2 characters, Conventional, Coal Bed, Chalk, Low Permeability,
followed by 3 Shale, and Unknown
spaces)
DATA CELL Alpha-numeric | 5 Identifies the data cell to which data apply. Data cell A _12A
NAME names are identified on the EIA-23 Form, included
with this document.
DATA CELL Alpha-numeric | Up to 50 Contains the data value for the data cell (identified on | 59872
VALUE (varies) the Form EIA-23 Form)

* The complete list of state subdivisions is found in the form instructions.

apIing s.J9sn (SOIY) walsAS Buuayes) uonewloju| SaAIasay £2-VI3 Wio-
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Sample Schedule A Data Record:

Record lype Comparly ID Subdivision Code F|eld Code Dda Cell Name
234 5 1 NKO 0 N 1 2234271
543 21 12112345 '7 A LS3
State Code FIPS County Code Type Code Data Cell Value
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2) Company Data: These data are identified by the Record Type “C”. Each record consists of the following:

Field name Type of data # of characters Description Examples
RECORD TYPE Alpha-numeric 1 Identifies the record as Company data C
COMPANY ID Numeric 6 ElA-supplied identification number 123456
DATA CELL NAME Alpha-numeric 5 Identifies the data cell to which data I_1A
apply. Data cell names are identified on
the EIA-23 Form, included with this
document.
DATA CELL VALUE Alpha-numeric Up to 50 (varies) Contains the data value for the data cell 59872, Smith Gas
(identified on the Form EIA-23 Form) Company, etc.

Sample Company Data Record:

Record Type Data Cell Name
ClL23456[I A
ClL23456[ 1A

mith Gas Company
ohn Doe

ClL23456 :1B 035551212

Company ID

Data Cell Value

NOTE: As shown in the sample records, all data fields must contain the exact number of characters
described. If necessary, a blank space (or several blank spaces) must be inserted if a field value
does not fill the required character length. For example, in the Sample Company Data Record
above, note that there is a blank space at the end of the Data Cell Name portions of the record,
because those particular cell names (I_A, | 1A, and |_1B) are less than 5 characters long — the 4"
and 5" characters must be filled with a blank space, where applicable. However, the final data field
(in both Schedule A and Company Records), Data Cell Value, need NOT have any blank spaces

inserted, as it is at the end of the record and place holders are not necessary.
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3) Footnote Data: These data are identified by the Record Type “F”. Each record consists of the following:

Field name Type of data # of Description Examples
characters
RECORD TYPE Alpha-numeric | 1 Identifies the record as Footnote data F
COMPANY ID Numeric 6 ElA-supplied identification number 123456
STATE CODE Alpha-numeric | 2 Identifies the state to which the footnote TX, AL
applies
SUBDIVISION CODE Alpha-numeric | 2 Identifies the subdivision of the state to 00 shall represent the
which the footnote applies subdivision for all federal
offshore, and 05 shall represent
the subdivision for all state
offshore.* A blank shall be one
of the choices on the list (some
states do not have
subdivisions).
3 Identifies the county to which the footnote
COUNTY CODE Alpha-numeric applies 101, 205
FIELD CODE Numeric 6 Iden.tifies the fiel.d to which the footnote 105223, 726588
applies. For a given state and county and
operator, a duplicate field code shall not be
allowed. Each Field code is made unique
by the use of state and county.
) Identifies the type of reservoir. These C, CB, CH, LP, SH, UN
TYPE CODE Alpha-numeric | 5 (2 characters | include Conventional, Coal Bed, Chalk,
followed by 3 Low Permeability, Shale, and Unknown
spaces)
2 Identifies the Item Number to which the 1,2,34,5,..15
Alpha-numeric footnote applies (corresponds to the item
ITEM NUMBER number found on the EIA-23 form).
Albh . 1 Identifies the column to which the footnote | A,B,C,D,E,F, G, H, I,J
COLUMN DESIGNATION pha-numeric applies
Up to 255 Text of the footnote This data entry changed over

FOOTNOTE

Alpha-numeric

20% in 2013 due to unusual
increase in cost.

Sample Footnote Record:

Record Type State Code County Code Type Code

FDO5766[T X
FDO5766[T X

Company ID Subdivision

111101865
111101865

Code

Field
Code Number

Column Designation

.

D[This is the footnote description for item = 12, column designation= D
FThis is the footnote description for item = 14, column designation= F.

\

Item

Footnote
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Import File Layouts - Part 2: Schedule A Spreadsheet File Format

The format that must be used in the Schedule A spreadsheet file in order to successfully import it into RIGS is as follows:

| ID |A1]Aa2|Aa3[Aaa A5 [city |Ae [A7alAmB|ATC|ATD]|AB|[A9]A 10[A 11]A 12A]
BITA
123456 AZ 001 066926 CB APACHE PEAK 43 o 78 0 0 0 1956 100

The sample above shows only a portion of the complete file. All import data columns are described below. The column names correspond to the
following fields in RIGS:

o

Company ID Number

Two-character State abbreviation

Subdivision Code

County Code

Field Code

Type Code

County Name

Field Name

Proved Non-Producing Reserves - Crude QOil

Proved Non-Producing Reserves - Associated-Dissolved Gas
Proved Non-Producing Reserves: Non-Associated Gas
Proved Non-Producing Reserves: Lease Condensate
Footnote Code

Water Depth

Field Discovery Year

Prospect Name

A: Total Proved Reserve: Crude QOil, as of Dec 31, 20014

>>I>>

SarwNE

>0 >
HeaeN-1
oO0ow>

PP PR O0NSNNNOD

>>>>>>>> >

0
1
_12

The remaining fields are not shown in the sample file above. They correspond with fields 12A through 12J (Crude Oil) on Schedule A, followed by 13A
through 13J (Associated-Dissolved Gas), then 14A through 14J (Non-Associated Gas), and 15A through 15J (Lease Condensate).
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.ela.doe.gov
Energy Information
Administration

eia

U.S. DEPARTMENT OF ENERGY
ENERGY INFORMATION ADMINISTRATION
Washington, DC 20585

Appendix B —
FORM EIA-23 - ANNUAL SURVEY OF DOMESTIC OIL AND GAS RESERVES
REPORT YEAR 20X X

Form Approved

OMB No. 1905-0057
Expiration Date: 12/31/XX
(Revised 20XX)

Data Cell Codes

This report is mandatory under the Federal Energy Administration Act of 1974 (Public Law 93-275). For
concerning the confidentiality of information and sanction statements, see Section VIl and VIII of the ins

NOTE: Data Cell Codes are listed in
Bold; Number of Characters

PART I. IDENTIFICATION

accepted in the field shown in

Complete and return by May X, 20XX to:

Oil and Gas Surveys
U.S. Department of Energy, EIA
Ben Franklin Station
P.O. Box 279
Washington, DC 20077-0279
OR
Fax to: (202) 586-1076 (FORM EIA-23L)

Company Name:
Street or P.O Box:
City, State, Zip Code:

EIN:
Questions? Call 1-800-879-1470

ElA Identification Number:

parentheses (), where applicable. If
no Data Cell Code is shown in the
field, that data cannot be imported.

Affix mailing lab

0 [©)] |

LA (50)
I_B (50)
I_C (city; 30) I_D (state; 2) I_E (ZIP; 10)
I_F (9)

1. Contact Information (person most knowledgeable about the reported | 2 was your company an oil and gas field operator at any time
data) during calendar year 20xx? (See definition of an operator,
Contact Person (Please Print): I_1A (50) page 1)

Phone Number: ( 1_1B )(10) - Ext. I_C (4) Q) O no.. Complete only items 3 through 15 below
. I_1D, (10 B,
Fax Number:  (—=——~) (10) @ O Yes.. Completerestofform. 1_2 (1) y/n
E-mail Address: I_1E (50)
3. Company Status, Name, and/or Address Change or Correction. (Check appropriate box.)
(@] Name and address on mailing label are correct. |_3A (1)
(@) Change company name, contact person, and/or mailing address as indicated below. 1 3B (1)
o Company was sold to or merged with company entered below. 1_3C (1)
(@] Company went out of business. Customer accounts taken over by company entered below. 1_3D (1)
4. Change Company Name, Address, EIN, and/or Contact Information to:
Company Name: L4A (50)
Street or P. O. Box: 4B (50)
City, State, Zip Code: 1_4C (city; 30) I_4D (state; 2) I_4E (ZIP; 10)
EIN: | 4F (9)
Contact Person (Please Print): I 4G (50)
Phone Number: (| 4H (10) - Ext. 1 41 (4)] Fax Number: (1 4J) (10) - E-Mail Address: 1 4K  (50)

Comments:

PART Il. PARENT COMPANY IDENTIFICATION

5. Is there a parent company which exercises ultimate 6. Company Name 7. Parent Company EIN
control over your company? 1_6 (50) 1_7
8. Address
(1) O No... Answer 12 through 15. | 5 (1) y/n I_8 (50)
9. Cit 10. State 11. Zip Code
@ O Yes... Answer 6 through 15. y 19 (30) i 10 (2) P 1 11 (10)
PART lll. APPROVAL
12. Attestor (Please Print) 13. Title
1.12 (50) 1_13 (50)
14. Signature 15. Date
1 15 (10)

Title 18 USC 1001 makes it a criminal offense for any person knowingly and willingly to make to any Agency or Department of the United States any false,

fictitious, or fraudulent statements as to any matter within its jurisdiction.
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ANNUAL SURVEY OF DOMESTIC OIL AND GAS RESERVES

Report All Liquid Volumes in Thousands of Barrels [Mbbl] at 60°F;
Report All Volumes of Natural Gas in Millions of Cubic Feet [MMcf] at 60°F and 14.73 psia

SCHEDULE A - OPERATED PROVED RESERVES, PRODUCTION, AND RELATED DATA BY FIELD

Form Approved

OMB No. 1905-0057
Expiration Date: 12/31/XX
(Revised 20XX

1.0 OPERATOR AND REPORT IDENTIFICATION DATA
1.1 OPERATORI.D. CODE 1.2 OPERATOR NAME REPORT DATE | 1.3 ORIGINAL | | 1.4 AMENDED | 15 PAGE
2 |3 [xx [ ] [ ] _ oF___
2.0 FIELD DATA (OPER ATED BASIS)
1. STATE 2. suBDIV. | 3. cOUNTY |a. FIELD 5. TYPE
ABBR. CODE CODE CODE CODE 6. FIELD NAME 7. PROVED NONPRODUCING RESERVES
8. FOOTNOTE
2 1 CRUDE OIL ASSOC-DISSOLVED NONASSOCIATED LEASE CON-
. A6 (5 0) (@) (Mbbi) (b) __GAS (MMcf) © GAS (MMcf) (d) DENSATE_(Mbbl)
— A7A 8| A 7B (8 A 7C (8) A7 8 | | |
9. WATER DEPTH | A 9 (5 10. FIELD DISCOVERY YEAR A 10 (4) | 11. PROSPECT NAME (Optional) A 11 (26)'
TOTAL NEW NEW CALENDAR TOTAL
TYPE OF HYDROCARBON PROVED RESERVES REVISION REVISION FIELD RESERVOIRS YEAR PROVED RESERVES
DECEMBER 31, 20XX INCREASES DECREASES SALES ACQUISITIONS EXTENSIONS DISCOVERIES IN OLD FIELDS PRODUCTION DECEMBER 31, 20XX
(A (8) © D) (E) =) ©) (H) () &)
12, CRUDE OIL (Mbk) A_12A (8) | A_12B (8)| A_12C (8)| A_12D (8)| A_12E (8) | A_12F (8 A_12G (8)| A_12H (8)] A_121 (8) A_12J (8)
15, ASSOCIATED-DISSOLVED GAS (M) A_13A (8) | A_13B (8) A_13C (8)| A 13D (8)] A_13E (8) | A_13F (8] A_13G (8)| A_13H (8)| A_13I (8) A_13J (8)
14, NONASSOCIATED GAS (M) A_14A 8) | A 148 (8)| A 14c @8)|A 14D 8)| A_14E (8) | A_14F (8)| A_14G 8) | A_14H (8) | A_141 (8) A 141 (8)
15, LEASE CONDENSATE (Mbb) A_15A (8) | A_15B (8)| A_15C (8)|A_15D (8)| A_15E (8) | A_15F (8)| A_15G (8) | A_15H (8) | A_151 (8) A_15J (8)
N
o 1. STATE | 2. suBDIV. | 3. counTY [4. FIELD 5. TYPE
ABBR. CODE CODE CODE CODE 6. FIELD NAME 7. PROVED NONPRODUCING RESERVES
8. FOOTNOTE
2 2 CRUDE OIL ASSOC-DISSOLVED NONASSOCIATED LEASE CON-
" (a) (MDbDbl) (h) GAS (MMcf) ) GAS (MMcf) (d) DENSATE _(Mbbl)
e
9. WATER DEPTH | 10. FIELD DISCOVERY YEAR 11. INDICATED ADDITIONAL RESERVES OF CRUDE OIL (Mbbl)
TOTAL PROVED NEW FIELD NEW CALENDAR TOTAL PROVED
TYPE OF HYDROCARBON RESERVES REVISION REVISION DISCOVERIES RESERVOIRS YEAR RESERVES
DECEMBER 31, 20XX INCREASES DECREASES SALES ACQUISITIONS EXTENSIONS © IN OLD FIELDS PRODUCTION DECEMBER 31, 20XX
(A (8) ©) D) (E) 6 (H) [0) )
12. CRUDE OIL (Mbbl)
13. ASSOCIATED-DISSOLVED GAS (MMcf)
14. NONASSOCIATED GAS (MMcf)
15. LEASE CONDENSATE (Mbbl)
1. STATE | 2. suBDIV. | 3. COUNTY |4. FIELD 5. TYPE
ABBR. CODE CODE CODE CODE 6. FIELD NAME 7. PROVED NONPRODUCING RESERVES
8. FOOTNOTE
2 3 CRUDE OIL ASSOC-DISSOLVED NONASSOCIATED LEASE CON-
" (a) (Mbbl). (h) GAS (MMcf) ) GAS (MMcf) (d) DENSATE _(Mbbl) | |
9. WATER DEPTH | 10. FIELD DISCOVERY YEAR 11. INDICATED ADDITIONAL RESERVES OF CRUDE OIL (Mbbl)
TOTAL PROVED NEW FIELD NEW CALENDAR TOTAL PROVED
TYPE OF HYDROCARBON RESERVES REVISION REVISION DISCOVERIES RESERVOIRS YEAR RESERVES
DECEMBER 31, 20XX INCREASES DECREASES SALES ACQUISITIONS EXTENSIONS © IN OLD FIELDS PRODUCTION DECEMBER 31, 20XX
(A) (B) © D) (E) =) (H) 0) 2

12.

CRUDE OIL (Mbbl)

13.

ASSOCIATED-DISSOLVED GAS (MMcf)

14.

NONASSOCIATED GAS (MMcf)

15.

LEASE CONDENSATE (Mbbl)
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20XX

ANNUAL SURVEY OF DOMESTIC OIL AND GAS RESERVES
SCHEDULE B — FOOTNOTES

Form Approved

OMB No. 1905-0057
Expiration Date:12/31/XX
(Revised 20XX)

1.1 OPERATOR I.D. CODE | REPORT DATE | 1.3 ORIGINAL | | 1.4 AMENDED | | 15 PAGE |
ID (6) 12 | 31 | XX | | | | | |
Page Field Designation Item Column FOR
Number (i.e., 2.1, 2.2 or 2.3) Number Designation Footnote DOE
@ ) © @ © USE ONLY
i N T

COLUMN DESCRIPTION

DATA FIELD Page

Number

FIELD_PAGENO

D Field Designation FIELD_DESIGNATOR
Item Number SUBITEM
Column Designation COL
N Footnote FOOTNOTE
\l

Items Numbered (I.E. 1. STATE, 2. SUBDIVISION, 3. COUNTY CODE, 4. FIELD CODE, 5. TYPE CODE DESIGNATION, 9. WATER DEPTH, 10.

DISCOVERY YEAR, AND 11. INDICATED ADDITIONAL RESERVES OF CRUDE OIL HAVE ONLY ONE COLUMN OF DATA.




Form EIA-23 Reserves Information Gathering System (RIGS) User's Guide

February 2016

Appendix C - State Abbreviation and Geographic Subdivision Codes

State Subdivision State Subdivision
State Name and Geographic Subdivisions Abbreviation Code State Name and Geographic Subdivisions Abbreviation Code
Alaska - South State Offshore AK 05 MiIChIQaN. ..o Blank
Alaska - South Onshore........cc.ccccovevveeiienne AK 10 Minnesota Blank
Alaska - North Onshore and Offshore.............. AK 50 Y TESTS] 0] U SRR Blank
Alabama - Onshore.........cccooieiniecieenc e AL Blank Mississippi - Onshore ........cccceovecnencinene. MS Blank
Alabama - State Offshore...... AL 05 Mississippi - State Offshore.........c.cccoeenenne MS 05
Arkansas AR Blank MONEANA .....oeecviiiece e MT Blank
AriZONA....ccoiieceeeeeeece e AZ Blank North Carolina...... ... NC Blank
California - State Offshore CA 05 North Dakota.........cccevevevievieie e ND Blank
California - San Joaquin Basin Onshore......... CA 10 NEDraska........ccccoureeenneenriee e NE Blank
California - Coastal Region Onshore................ CA 50 New Hampshire ... ... NH Blank
California - Los Angeles Basin Onshore.......... CA 90 NEW JEISEY...corveuiirieieeririeieiresie e NJ Blank
Colorado.....cceceieceeececesee e (0] Blank New MexiCo - EaSt.....ccccccvvevevnerenisieeceenn NM 10
Connecticut.......ccccevevevennennn, CT Blank New Mexico - West.... NM 50
District of Columbia DC Blank Nevada........... Blank
Delaware.........ccccoeveievecvirennns DE Blank New York....... Blank
Federal Offshore - AtlantiC.........cccccevvevevecvenennn. AC 00 (@] o1 T SO RRPR Blank
Federal Offshore - Gulf of Mexico OKIahoma....cccvvciceeeee e Blank
(Alabama)........ccccveievreeieiereresee e AL 00 Oregon............... Blank
Federal Offshore - Gulf of Mexico Pennsylvania Blank
([0 [0 F= ) USSR FL 00 Rhode Island Blank
Federal Offshore - Gulf of Mexico South Carolina........ccccecevevevieninieieesesese e Blank
(LOUISIANA) ...t LA 00 South Dakota ........cccevvieeicenieicescesec e Blank
Federal Offshore - Gulf of Mexico TEenNesSee......covvvevveuvrenne. Blank
(MISSISSIPPI)..vivereiriieisieeiereeese e MS 00 Texas - State Offshore......ccccccevevvvvecenenene, X 05
Federal Offshore - Gulf of Mexico Texas - Railroad Commission District 1...... TX 10
(Other GUI) .o oG 00 Texas - Railroad Commission District 2
Federal Offshore - Gulf of Mexico (@] 1] g [0 (= IS TX 20
(=2 G L) RS TX 00 Texas - Railroad Commission District 3
Federal Offshore - Pacific (Alaska)................... AK 00 ONSNOTE ..o TX 30
Federal Offshore - Pacific (California).............. CA 00 Texas - Railroad Commission District 4
Federal Offshore - Pacific (Oregon)................. OR 00 ONSNOTE.....ooiiicr s TX 40
Federal Offshore - Pacific (Washington)......... WA 00 Texas - Railroad Commission District 5....... TX 50
Florida - Onshore.......c.ccccoovevvviecicceiececeee e FL Blank Texas - Railroad Commission District 6....... TX 60
Florida - State Offshore?...........cccccccoeeveuvererrenne. FL 05 Texas - Railroad Commission District 7B.... TX 70
(CT=T0] (o[- USSR GA Blank Texas - Railroad Commission District 7C.... TX 75
Hawaii HI Blank Texas - Railroad Commission District 8....... TX 80
lowa....... IA Blank Texas - Railroad Commission District 8A.... TX 85
Idaho...... ID Blank Texas - Railroad Commission District 9....... TX 90
HINOIS . IL Blank Texas - Railroad Commission District 10.... TX 95
Indiana IN Blank ULah oo Blank
Kansas KS Blank Virginia Blank
KeNTUCKY ... KY Blank VermONt.. .o Blank
Louisiana - South State Offshore...........cccc....... LA 05 WaShington.........cccoveeinneieinnceneeenee Blank
Louisiana - South Onshore........c.ccccccvvevieennenene LA 10 Wisconsin......... Blank
Louisiana - NOrh .......cccccoevveeveieceeececee e LA 50 West Virginia Blank
Massachusetts MA Blank WYOMING .ttt Blank
Maryland.........ccocooenenne e MD Blank
MAINE....c.iiiieeciereei e ME Blank National Totals .....ccccocevevivenereceeesecee, YA YA
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